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Article 
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Abstract: Canistel (Pouteria campechiana (Kunth) Baehni) (yellow sapote, canistel). Originally from Mexico, the 

fruit is edible, and the tree is used as an ornamental and medicinal plant. Descriptive studies were carried out 

with the objective of morphologically characterizing the fruits and leaves of trees located in different regions 

of Mexico to select outstanding specimens and propose their massive reproduction. The trees were selected in 

three zones. In zone 2 from flower anthesis to harvest 11 months, fruits with 3 seeds, greater weight (180 to 330 

g) and quantity of pulp (198.88 g), subglobose shape, total soluble solids 33 %. The fruits of zone 1 at harvest 8 

months and zone 3 took 9 months to be harvested, in the rest of the characteristics evaluated were exceeded by 

the fruits of zone 2. To characterize the canistel (P. campechiana) leaf and identify accessions or cultivars, the 

three main variables, according to the principal component analysis were: leaf area, perimeter, and minor 

diameter. The three zones where canistel fruits and leaves were characterized are important and can be 

recommended for propagation in zones with favorable climatic conditions for fruiting in tropical and 

subtropical regions of Mexico.  

Keywords: yellow sapote; tree selection; viviparity; leaf characterization; early seed germination 

 

1. Introduction 

Due to climate change, it is no longer necessary to focus research in obtaining seeds with high 

productive potential, to satisfy a changing and dynamic market at national and international level; 

the theme should be directed to produce species with high nutritional and medicinal potential; even 

more if the center of origin is Mexico, such is the case of Pouteria campechiana (Kunth) Baehni 

(synonymy: Lucuma salicifolia Kunth, Lucuma campechiana Kunth, Lucuma nervosa A. DC, Achras 
lucuma); commonly known as egg fruit tree, canistel, drunken sapote and yellow sapote [1].  

There are reports that canistel presents compounds in the fruit such as polyphenols with antioxidant 

activity [2]; in seeds and leaves it contains flavonoids (myricetin, quercetin); phenolic compounds, 

terpenes, among other compounds; ethanolic extracts of canistel seed and leaves are used in 

alternative medicine, recommended as anti-inflammatory and gastrointestinal disorders by the 

phenolic compounds (gallate acid)[3]; antioxidant by the flavonoid compounds (myricetin and 

quercetin (myricetin and quercetin) [4, 5]. The bioactive compounds reported for this species may not 

be the same or differ in concentration, such is the case of phenols reported by Ma et al. [6] and Kong 

et al. [7]; these differences may be attributed to the environment in which they develop, season of the 

year, soil, and management [8]. 

These references justify the study of canistel in Mexico, where there are specimens in backyard 

cultivation in the Morelos state; located in the municipalities of Yautepec and Jiutepec; also, in the 
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Emiliano Zapata Experimental field (thirty trees) (south side of the municipality of Yautepec), the 

latter is the seed from subsidiary 1 of Jiutepec [9]; because of the canistel is a tree reported ornamental, 

medicinal and fruitful interest, it is important to describe samples of these trees from these three 

localities to implement propagation by seed. 

The objective was to characterize fruits, seeds, leaves and harvest time of canistel trees located in 

different areas of Mexico. This information was fundamental, since the data obtained led to 

recommend this fruit tree in other areas with similar climatic conditions; The initial assignments were 

to plant trees in public spaces, gardens, educational centers and/or in crops associated with other 

fruit trees.  

2. Materials and Methods 

2.1. Study zones 

Canistel collection regions were geolocated, as well as the climate description; zone 1 and zone 

2, each with a tree under backyard cultivation; zone 3, corresponds to seed subsidiary 1 of zone 2. 

2.2. Planting material: growing conditions and selection  

Once the trees to be sampled were located with constant walks and monitoring (fruiting), fruits 

and leaves were harvested. The maturity criterion for fruit harvest was semi-ripe [10]; Leaves were 

collected ripe and of homogeneous color without phytosanitary problems; both leaves and fruits 

were transported in a cooler to the laboratory and placed on a table, so that they would lose the heat 

of the field [11]. 

After receiving the material, the fruits and leaves were cleaned with wet flannel. The cleaned, 

sanitized, and dried leaves were placed between two thin transparent glasses for 6 h so that they 

would not lose their shape. 

2.3. Fruit characterization  

The canistel fruits were numbered (20 fruits harvested at random), weighed on a digital balance 

(MediaDeta DS-5); the polar diameter (from the base to the distal part or protuberance of the fruit), 

the equatorial diameter (the widest part of the fruit) (digital caliper brand: Titan model: 55674 of 15.24 

cm. China). Then, both pulp and seeds were weighed, and the number of seeds with premature 

germination was recorded. Total soluble solids (TSS) which indicate sucrose content and includes 

carbohydrates, organic acids, proteins, fats, and minerals of the fruit (28 to 62 % Fisher (Japan) 

refractometer) [12]. 

2.4. Morphological leaf characterization 

Images of five mature leaves from the adaxial and abaxial face (Figure 1A) were captured in RGB 

under a digital camera (FUJIFILM FinePIX S8600, f=4.5 - 162 1:2 9-6.9 lens, Japan) and connected to a 

personal computer and stored in JPG format at 1322 × 3128 pixels. These images were converted to a 

grayscale format with ImageJ 1.43u software (NIH, USA), to set the correct scale (Analyze > Set Scale 

> adjust the actual distance) and the Threshold tool (from 5 ± 1 to 79) was applied to segment the 

image (Image>Threshold>Apply), with the segmented image the dimensions were evaluated in mm, 

with after selection of the variables to be measured. These measurements were performed with the 

Analyze>Measure tools. The results of the variables assessed for leaf characterization were arranged 

in a data matrix for processing and analysis. The selected variables are indicated in figure one (Figure 

1A–C): 

- Area: The number of pixels within a shape bounded by a perimeter, also called leaf area. 

- Perimeter: The number of pixels at the boundary of the object, in this case the leaf. 

- Major diameter: corresponds to the length of the leaf. 

- Minor diameter: is the width of the leaf. 
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- Circularity: It is a measure of the ratio of the area and perimeter, which excludes local 

irregularities this value is equal to 1 for a circular object and less than 1 for an object that departs 

from circularity. 

- Solidity: It is the density of pixels, it indicates how many pixels are joined without leaving blank 

spaces, an object with higher solidity has no blank spaces, and an object with low solidity has 

blank spaces, like gaps. 

- The angle of the leaves was evaluated by manually segmenting and marking the main and 

secondary veins of each leaf on the abaxial face as follows: Freehand line> Draw> Measure. 

 

Figure 1. Canistel tree leaf with the evaluated variables description. 

2.5. Statistical analysis  

Statistical assessment of the fruits was performed using the mean ± standard error of the mean 

(SEM), statistical significance by one-way analysis of variance (ANDEVA). Values p<0.05 were 

considered significant. With the results obtained from the climate, fruit and leaf characteristics, the 

differences and similarities of the trees located in the three zones were statistically defined. The data 

obtained were processed by one-way analysis of variance (ANDEVA) with p< 0.05 and the 

application of Bonferroni's multiple comparisons test [13]. Values were analyzed with SPSS Statistics 

software version 20. Principal component analysis was performed with Minitab 17 software for leaf 

data only. 

3. Results 

3.1. Study zones  

The characteristics of the three canistel leaf and fruit harvest zones were analyzed. Table 1 shows 

the climatic characteristics of each study zone to relate this information to the morphological 

variation of fruits and leaves (Figure 2A,B). 

Table 1. Characteristics of the three collection areas of canistel (Pouteria campechiana) fruits 

and leaves considered as a phytogenetic resource in Mexico. 
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 Study Zones 

Descriptive  

characteristics 
Zone 1 Zone 2 Zone 3 

Geo location 
18.87595 LN-99.077464 

LW 

18.884546 LN-99.17745 

LW 

18.824988 LN-

99.096042 LW 

Locality Yautepec de Zaragoza Jiutepec Yautepec de Zaragoza 

Neighborhood Otilio Montaño Centro de Jiutepec San Isidro 

m.a.s.l.1 1210 1350 1059 

Weather 

Semi-humid sub-humid 

(66% of the year), the 

warmest of the 

temperate climates. 

Warm subhumid (34%), 

with summer rains, the 

driest of the subhumid 

climates, low oscillation. 

Semi-warm and sub-

humid (28 %), the 

coolest of the warm 

ones. 

Warm sub-humid with 

summer rainfall (72 %), 

the highest percentage 

of the year. 

Warm sub-humid 

(100%), dry (low 

deciduous forest). 

Precipitation 

Summer, the 

intermediate of the sub-

humid (rainfall 

concentrated in 

summer). Months 

without rain from 

November to April 

The average annual 

rainfall is 1,021 mm and 

the rainy season is from 

June to October, with 

890 mm. 

Summer rainfall. 

Percentage of winter 

rainfall less than five. 

Temperature 

Hot summer (34 °C ± 4), 

extreme (at night 

temperature drops 18 °C 

± 3); Ganges-type 

temperature march 

(with the highest 

temperature in May, 

before rainning and the 

summer solstice; 

Ganges-type, due to the 

similarity of the climate 

in the Ganges River 

delta region in India. 

Isothermal (the average 

thermal variation of the 

year does not exceed 3 

°C), Ganges type 

temperature march. 

During the year it varies 

from 11°C to 32°C. The 

average 21.2°C; the 

maximum average 

variation is 31.4°C. The 

absolute maximum is 

39.8 °C. 

The hottest months are 

April and May, and the 

coldest months are 

December and January. 

Extreme hot summer, 

hot day (35 °C ± 3) in 

the evening 

temperature drops (20 

°C ± 3); the rest of the 

year behaves similarly. 

Harvest season 

(Months) 
November- December May- July March- April 

Early seed  

germination (%) 
0.2 30 0.1 
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1m.a.s.l.: meters above sea level. [14]. 

 

Figure 2. Climatic table with historical climate data in the collection zones of canistel (Pouteria 
campechiana) (A) Zone 1 and 3, (B) Zone 2. 

3.2. Fruit characterization  

The fruits of zone 2, presented greater weight (180 to 330 g), sub globose shape and quantity of 

pulp (198.88 g), 3 seeds with an average weight of 19.71 g. In addition, they showed significant 

statistical differences in polar and equatorial diameter and total soluble solids with respect to zones 

1 and 3 (Table 2). 

Table 2. Morphological and chemical characteristics of canistel (Pouteria campechiana) fruits collected 

in three areas of Mexico. 

Parameters 

Zone 1 Zone 2 Zone 3 

Mean 
Standard 

deviation 
Mean 

Standard  

deviation  
Mean 

Standard  

deviation 

Fruit weight (g) 146.24b 25.11 261.94a 76.78 160.18b 51.64 

Fruit polar diameter (cm) 9.49b 1.16 11.03a 0.84 9.07b 0.97 

Fruit equatorial diameter 

(cm) 
5.49b 0.46 7.29a 0.96 6.03b 0.93 

Pulp diameter (g) 122.76b 27.62 198.88a 54.39 101.26b 35.87 

Number of seeds 1.12b 0.33 2.59a 0.87 1.29b 0.47 

Seed weight (g) 10.12b 2.26 19.71a 5.68 19.78a 3.29 

Seed polar diameter (cm) 4.29a 0.45 4.49a 0.26 5.50b 0.57 

Seed equatorial diameter 

(cm) 
2.08a 0.28 2.24a, b 0.17 2.40b 0.22 

Total soluble solids (SST) 27.47b 2.79 33.18a 0.39 26.12b 1.22 
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Values in the same row and sub table that do not share the same subscript are significantly different 

at p< 0 .05 in the test for bilateral equality of column means. The tests assume equal variances 1.1Using 

the Bonferroni correction. 

In canistel, from anthesis (Figure 2) to fruit harvest in zone 2 was 11 months, in zone 1 8 months 

and in zone 3 9 months; the morphological variation of the fruits can be seen in Figure 2, which shows 

the fruits collected in the 3 zones. 

 

Figure 3. (A) Canistel (Pouteria campechiana) flower at anthesis of and fruits of the three zones, (B) zone 

1, (C) zone 2 and (D) zone 3. 

3.3. Leaf morphological characterization  

The leaf area of the 3 zones was statistically different, with zone 3 having the largest leaf area. 

Leaf perimeter in the three zones showed different values, zone 3 with a greater perimeter than zone 

2 and zone 1 respectively; major diameter (length) with a significant difference in zone 2, zones 1 and 
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3 are statistically equal; the minor diameter in the three zones was different. The circularity index for 

the three zones was different and for the soundness index only zone 3 showed a difference. The angle 

variable was different only in zone 3 (Table 3). 

Table 3. Morphological characteristics of leaves collected in three zones of Mexico. 

Parameters 

 LEAVES 

Zone 1 Zone 2 Zone 3 

Mean Mean Mean 

Area 52.52b 48.95a 63.54c 

Perimeter 44.79b 46.73a 48.46c 

 Major diameter 16.14b 16.52a 15.99b 

 Minor diameter 4.10b 3.77a 5.07c 

Circularity 0.33b 0.28a 0.34c 

Solidity 0.92a 0.92a 0.90b 

Angle 48.46a 45.42a 56.67b 

Note: Values in the same row and subtable that do not share the same subscript are significantly 

different at p<0.05 in the test for bilateral equality of column means. Tests assume equal variances1 1 

Using Bonferroni correction. 

3.4. Correlation analysis 

In the correlation analysis of the morphological variables assessed in the canistel leaves, a very 

high correlation was found for the variables area and minor diameter, with a high correlation 

between perimeter and major diameter, as well as minor diameter and circularity. The variables area 

and circularity, area and perimeter were moderately correlated (Table 4). 

Table 4. Pearson correlation between the variables measured in the canistel leaves of the 3 zones. 

 Area Perimeter 
Major  

diameter 

Minor 

diameter 
Circularity Solidity 

Perimeter 0.643 

0.000** 
     

Major diameter 0.515 

0.000** 

0.760 

0.000** 

 

 
   

Minor 

diameter 

0.911 

0.000** 

0.399 

0.000** 

0.120 

0.017* 
   

Circularity 0.552 

0.000** 

-0.279 

0.000** 

-0.171 

0.001** 

0.700 

0.000** 
  

Solidity -0.291 

0.000** 

-0.466 

0.000** 

-0.076 

0.129 NS 

-0.324 

0.000** 

0.162 

0.001** 
 

Angle 0.277 

0.000 NS 

0.018 

0.724** 

-0.070 

0.163** 

0.356 

0.000 NS 

0.331 

0.000 NS 

-0.124 

0.013 NS 

Not significant NS, and significant at a p≤0.05* and p≤0.001**. 

3.5. Principal component analysis  

In the principal component analysis, the eigenvalues indicated that the first principal component 

contributes 43.7 % of the total variability, the second component 28.1 %, and the third component 
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14.5 %; this shows that the combination of the first three components describes the 86.4 % variability 

of the data (Table 5). 

Table 5. Eigenvalues, absolute and cumulative percentage of variance of the principal components of 

the canistel leaves analysis. 

Principal   

component 
Eigenvalue Variance (%) 

Cumulative 

Variance (%) 

1 3.0615 43.7 43.7 

2 1.9676 28.1 71.8 

3 1.0175 14.5 86.4 

4 0.7358 10.5 96.9 

5 0.2118 3 99.9 

6 0.0045 0.1 100 

7 0.0013 0 100 

In relation to the eigenvectors, the variable that contributed most to the first component was the 

area with 0.559, then was the smallest diameter with 0.507; in the second principal component were 

the variables perimeter (0.476) and circularity (-0.588); finally, in the third component were the 

variables solidity with -0.765 and largest diameter with -0.434 (Table 6). 

Table 6. Eigenvectors of the first three principal components from the analysis of the variables in the 

canistel leaves. 

Variable 
Principal Components 

1 2 3 

Area 0.559 -0.056 -0.174 

Perimeter 0.408 0.476 0.006 

Major Diameter 0.300 0.454 -0.434 

Minor Diameter  0.507 -0.270 0.029 

Circularity 0.256 -0.588 -0.243 

Solidity -0.254 -0.216 -0.765 

Angle 0.212 -0.313 0.370 

The two-dimensional diagram shows the projection of the variables on the first 2 principal 

components. The variables projected on the plane, match the results obtained, where area and minor 

diameter contribute most to the variation of the data in the first component; in the second component 

they were perimeter and major diameter (Figure 4). 
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Figure 4. Two-dimensional diagram for the variables measured on the leaves, showing the projection 

of the zones on the first two principal components. 

4. Discussion 

The altitude above sea level (m.a.s.l.) and climate showed differences in the three collection 

zones (Table 1). Zone 2, had the highest altitude (1350 m), followed by zone 1 (1210 m) and 3 (1059 

m). Pennington and Sarukhán [15], reported that canistel has been found at sea level and up to 1400 

m in tropical and subtropical climates, this indicates that they are within altitude conditions. In 

general, altitude has an influence on the time of fruit development and ripening; this was reflected in 

the time of harvest; the fact that fruit development takes longer does not mean that the quality 

decreases [16] (Table 1). 

Zone 2 is isothermal; this makes it different from the other two zones; 72% of the year it has a 

warm climate, the average annual temperature is higher than 22 °C; it is sub-humid most of the year. 

In the three zones, April and May are the months in which high temperatures predominate and 

precipitation is in summer; the heat wave is presented in the three zones, more markedly in zone 1, 

the community of this zone calls it Verano de Santiago (days when it does not rain), [17] 

The climatic conditions of zone 2, could be related to the number of seeds, those of this zone 

presented on average 3 seeds and a high percentage of viviparity (30 %). In studies such as Atapattu 
et al. [18] (2014) reports weight of 175 g (Sri Lanka, average temperature of 29 °C); Kong et al. [7] 

reports weight of 118.09 ± 35.48 g (Malaysia, average temperature of 28 °C); The fruits of zone 2, 

exceed these weights, but not those of zone 1 and 3.  

The fruits of zone 2, take longer to reach the semi-mature stage, and the climate is more stable, 

during the development period, the amount of precipitation is lower; as Dussi [16] mentions that the 

fruits may take more or less time to develop, this does not demerit the quality, apparently, they 

accumulated more sugars. 

Multiple factors could contribute to premature seed germination, Cota-Sánchez et al. [19] 

mentioned that it is possible for the local environment and the age of the tree. Baskin and Baskin [16] 

mentions to these factors adds genotype; early germination in angiosperms can occur in fruit seeds 

in the same species but grown in different environments [20]. 

Among the factors also studied is temperature, Penfield, and MacGregor [21] report that high 

temperature is detected by the plant and transmitted to the fruit developing through signaling. 

Canistel fruits from zone 2, were harvested during the months of May to July (Table 1); These were 

the highest temperature months. This study suggests that the temperature factor had an influence on 

early seed germination [22].  
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The accumulation of proteins and starch also favors premature germination, as demonstrated 

by Borisjuk et al. [23] in broad bean (Vicia faba); in canistel in green state the humidity is 33.9 %, the 

pulp has 16 °Bx, and starch 38.9 % which could favor premature germination. Farnsworth [24] writes 

that to understand the physiology it is necessary to relate the ecology and evolution of the species. 

Colunga-García-Marín and Zizumbo-Villarreal [25], catalog the canistel as a non-domesticated fruit 

tree. 

On the other hand, with the data obtained from the leaves, 84.6 % of the variability represented 

by the first three principal components is sufficient to explain the variability that exists among the 

leaves of the three study zones with the selected variables. According to these data, leaf area, minor 

diameter and perimeter are the variables that differentiate the leaves, of which the area measures the 

size, the perimeter the shape and the minor diameter the width or amplitude of the leaf, which is also 

positively related to the area. There are different factors by which morphological changes occur in 

plants that, although belonging to the species, there is variability mainly in shape and size, one of 

these factors is temperature [26], in this case, although the canistel crops are relatively close, the 

climatic conditions, especially temperature, directly influences the development of the plant and 

fruiting. 

By its nature, the production of fruit trees is a source of permanent employment, income, other 

activities, or products derived from them, so that the cultivation of fruit species is, since its inception, 

an activity of great economic and social importance within the agricultural industry.  

5. Conclusions 

The canistel fruits and leaves studied morphologically in three zones of Mexico, it was found 

that the tree located at the highest altitude above sea level (zone 2) presented the highest number of 

seeds and high early germination; they took more months to become semi-ripe; the main attributes 

were the high percentage of flesh and the percentage of total soluble solids. The tree from zone 3 

(subsidiary 1 from zone 2) behaved differently from those harvested in zone 1 and zone 2. 

The leaves of the tree are elongated in shape and the angle formed by the primary ribs with 

respect to the secondary ribs are narrow (webbed appearance), the leaf area is smaller and 

consequently the perimeter is smaller. In terms of solidity, it means that the perimeter is smooth with 

very little undulation. 

To characterize the canistel (P. campechiana) leaf with these three main variables (leaf area, 

perimeter, and minor diameter) it is possible to identify accessions or cultivars. 
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